
Q.1 C is the third proportional of 29 and B. If B is the sum of the first three even natural
numbers, then find the value of C.
(Rounded off to two decimal places)

Ans 1. 3.53

2. 3.85

3. 7.64

4. 4.97

Q.2 Which of the following rivers flows through Rajasthan?
Ans 1. Teesta

2. Tapi

3. Luni

4. Jhelum

Q.3 Who among the following won the 2024 US Open Women's Singles title?
Ans 1. Coco Gauff

2. Iga Świątek

3. Aryna Sabalenka

4. Elena Rybakina

Q.4 Which of the following numbers is divisible by both 6 and 31?
Ans 1. 3720

2. 2132

3. 4916

4. 2858

Q.5 Which of the following is the primary basis for allocating seats in the Rajya Sabha
among various States and Union Territories in India?

Ans 1. Economic contribution of each state

2. Population of each state or union territory

3. Geographical area of each state

4. Literacy rate of the population

Test Date 11/06/2025
Test Time 12:45 PM - 2:15 PM
Subject RRB NTPC Graduate Level I
* Note
Correct Answer will carry 1 mark per Question.
Incorrect Answer will carry 1/3 Negative mark per Question.

1. Options shown in green color with a tick icon are correct.
2. Chosen option on the right of the question indicates the option selected by the candidate.

Section : RRB NTPC Graduate Level I

Click To Join Telegram PARMARSSC



Q.6 In a certain code language, ‘PACE’ is coded as ‘2468’ and ‘COST’ is coded as ‘1327’.
What is the code for ‘C’ in the given code language?

Ans 1. 6

2. 1

3. 7

4. 2

Q.7 The quadratic equation 2x2 + 4x + 8 = 0 has:
Ans 1. two equal real roots

2. two distinct real roots

3. more than 2 real roots

4. no real roots

Q.8 If '+' means '−', '−' means '×', '×' means '÷' and '÷' means '+', then what will come in place
of the question mark (?) in the following equation?

55 – 8 ÷ 3 + 15 × 5 = ?
Ans 1. 440

2. 400

3. 420

4. 450

Q.9 Pipes A and B can fill an empty cistern in 84 minutes and 36 minutes, respectively. Both
Pipe A and Pipe B are opened together. After how much time should Pipe B be turned
off so that the empty cistern is completely filled in a total of 42 minutes?

Ans 1. 18 minutes

2. 12 minutes

3. 15 minutes

4. 24 minutes

Q.10 What was the sex ratio in India as per the 2011 Census data?
Ans 1. 943 females per 1000 males

2. 950 females per 1000 males

3. 940 females per 1000 males

4. 948 females per 1000 males

Q.11 Which Indian state shares its border with Bhutan and Bangladesh?
Ans 1. Assam

2. Meghalaya

3. Mizoram

4. Sikkim

Q.12 This question is based on the five, three-digit numbers given below.

(Left) 236 758 230 563 263 (Right)

(Example- 697 – First digit = 6, second digit = 9 and third digit = 7)
(NOTE: All operations to be done from left to right.)

What will be the resultant if the first digit of the lowest number is subtracted from the
first digit of the highest number?

Ans 1. 5

2. 6

3. 8

4. 4
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Q.13 According to the Periodic Labour Force Survey (PLFS) report, what was the Labour
Force Participation Rate (LFPR) for women in 2021-22?

Ans 1. 42.7%

2. 23.5%

3. 14.8%

4. 32.8%

Q.14 The Maitrakas of Valabhi were initially the:
Ans 1. rivals of the Guptas

2. subordinates of the Guptas

3. rulers of an independent empire

4. part of the Hunas

Q.15 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of :: ?

# : NHP :: RLT : %
Ans 1. # = OIR , % = QKS

2. # = OIQ , % = QLS

3. # = OIQ , % = QKR

4. # = OIQ , % = QKS

Q.16 A, B, C, D, R, S and T are sitting around a circular table facing the centre of the table. B
sits fourth to the right of R. Only two people sit between T and D when counted from the
left of T. A sits third to the left of C. S is an immediate neighbour of C and D. How many
people sit between B and S when counted from the left of S?

Ans 1. Two

2. One

3. Three

4. Four

Q.17 This question is based on the five, three-digit numbers given below.

(Left) 144 743 290 258 799 (Right)

(Example- 697 – First digit = 6, second digit = 9 and third digit = 7)
(NOTE: All operations to be done from left to right.)

What will be the resultant if the second digit of the highest number is subtracted from
the third digit of the lowest number?

Ans 1. −5

2. −4

3. −6

4. −2

Q.18 What is the mode of the following data?
77, 86, 89, 74, 69, 84, 87, 80, 60, 64, 79, 63, 83, 82, 81, 89, 80, 69, 73, 74, 87, 68, 74, 77, 67,
74

Ans 1. 74

2. 86

3. 89

4. 77
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Q.19 What sum of money (in ₹) will amount to ₹720 at 4% per annum simple interest in 5
years?

Ans 1. 600

2. 650

3. 550

4. 3,600

Q.20 Two positive numbers differ by 2858. When the greater number is divided by the smaller
number, the quotient is 5 and the remainder is 178. What is the HCF of the greater of the
two given numbers and 3828?

Ans 1. 17

2. 13

3. 12

4. 11

Q.21 Which of the following statements is true about the Permanent Lok Adalat under
Section 22-B of The Legal Services Authorities Act, 1987?

Ans 1. The award of the Permanent Lok Adalat is not binding on the parties.

2. The Permanent Lok Adalat has jurisdiction over disputes related to criminal offences.

3. The Permanent Lok Adalat can only act as a conciliator and cannot decide disputes.

4. The Permanent Lok Adalat can handle cases up to a certain monetary limit (currently ₹1 crore).

Q.22 What was the unknown element under aluminium called?
Ans 1. Neo-Aluminium

2. Proto-Aluminium

3. Eka-Aluminium

4. Meta-Aluminium

Q.23 As per the SDG India Index 2023-24, what was the estimated percentage of reduction in
the population living in multidimensional poverty between 2015-16 and 2019-21?

Ans 1. From 30% to 20%

2. From 24.8% to 14.96%

3. From 20% to 12%

4. From 15% to 10%

Q.24 What should come in place of the question mark (?) in the given series?

402 400 396 390 382 ?
Ans 1. 376

2. 370

3. 372

4. 374
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Q.25 In this question, a group of numbers is coded by using letters and symbols as per the
table given below and the conditions which follow.

Number 7 8 2 3 4 5 6
Code Z Q # @ % $ U

Conditions:
1. If the 1st and 2nd digits are even, both are to be coded as ‘A’.
2. If the 1st and last digits are odd, both are to be coded as the code for the 1st digit.
3. If the 3rd and 4th digits are even, their codes are to be interchanged.

What is the correct combination of codes (by following only the applicable condition(s))
for the given digits?

48719
Ans 1. Q Q Z J S 

2. % Q Z J S

3. A A Z J S 

4. % % Z J S 

Q.26 A shopkeeper marks the price of an article at ₹5,960. Find the cost price if after allowing
a discount of 9% he still gains 30% on the cost price.

Ans 1. ₹4,277

2. ₹4,154

3. ₹4,172

4. ₹4,142

Q.27 Which of the following is not a 'Ghana Vadya'?
Ans 1. Mridangam

2. Manjira

3. Khartal

4. Jaltarang

Q.28 Which of the following statements about Small Causes Courts is correct?
Ans 1. They can hear appeals from Nyaya Panchayats.

2. They deal exclusively with criminal cases of a minor nature.

3. Their decisions are final but subject to High Court’s revision.

4. They exist in all states under a uniform nomenclature.

Q.29 What should come in place of the question mark (?) in the given series based on the
English alphabetical order?

ZYB GFI NMP UTW ?
Ans 1. BDA

2. ADB

3. BAD

4. ABD

Q.30 P, Q, R, S, T, U and V are sitting around a circular table facing the centre. Only two
people sit between T and Q when counted from the left of Q. U sits third to the left of S.
P sits to the immediate right of S. P sits second to the left of T. V is an immediate
neighbour of U. How many people sit between Q and R when counted from the left of R?

Ans 1. 4

2. 2

3. 3

4. 1
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Q.31 Which of the following letter-number clusters will replace the question mark (?) in the
given series to make it logically complete?

EK19, GM28, IO37, KQ46, ?

Ans 1. MR56

2. MR55

3. MS55

4. MS56

Q.32 According to the United Nations Convention on the Law of the Sea (UNCLOS), India’s
Exclusive Economic Zone (EEZ) extends upto __________.

Ans 1. 500 nautical miles

2. 300 nautical miles

3. 400 nautical miles

4. 200 nautical miles

Q.33 From a point 15 m away from the base of a tree, the angle of elevation to the top is 45°.
What is the height of the tree?

Ans 1. 10 m

2. 18 m

3. 15 m

4. 12 m

Q.34 Who among the following has been appointed as the Private Secretary to the Prime
Minister Narendra Modi in March 2025?

Ans 1. Anju Rathi

2. Amitabh Kant

3. Ajay Bhadoo

4. Nidhi Tewari

Q.35 What happens when you use the Format Painter tool in MS Word?
Ans 1. It changes the page orientation.

2. It inserts a hyperlink.

3. It deletes the selected text.

4. It copies formatting (e.g., font, color) from one piece of text to another.

Q.36 Akshay has ₹1,218 with him. He divided it amongst his sons Arjun and Kartik and asked
them to invest it at 10% rate of interest per annum, compounded annually. It was seen
that Arjun and Kartik got the same amount after 12 and 13 years, respectively. How
much amount (in ₹) did Akshay give to Kartik?

Ans 1. ₹430

2. ₹580

3. ₹638

4. ₹738

Q.37 Which feature of the phosphodiester bond contributes most to the overall negative
charge of the DNA molecule?

Ans 1. The phosphate group’s ionisable oxygen atoms

2. The ribose sugar

3. The methyl group of thymine

4. The nitrogen in purines

Click To Join Telegram PARMARSSC



Q.38 Which of the following statements regarding the Supreme Court's interim order in the
Ranveer Allahbadia case (February 2025) is/are correct?
The Supreme Court granted interim protection to Allahbadia but harshly criticised his
remarks as obscene and vulgar.
The Court ruled that Allahbadia was free to travel abroad without any restrictions since
the remarks were made behind a paywall.

Ans 1. Neither 1 nor 2

2. Both 1 and 2

3. Only 2

4. Only 1

Q.39 The mean and the mode of a set of data are 47.4 and 61.6, respectively. Find the median
of the data set, using the empirical formula.
(Round off your answer to one decimal place.)

Ans 1. 53.8

2. 52.1

3. 51.7

4. 52.7

Q.40 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of :: ?
# : LIE :: SPL : %

Ans 1. # = OLH, % = PMI

2. # = PQH, % = GVI

3. # = OLT, % = OAI

4. # = OOI, % = PDF

Q.41 The Charter Act of 1833 created a separate ______.
Ans 1. Federal Court

2. Supreme Court in Madras

3. Law Commission in India

4. Legislative Assembly in Delhi

Q.42 Which of the following cities hosted the important 20th Dialogue event in December
2024?

Ans 1. Doha, Qatar

2. Manama, Bahrain

3. Riyadh, Saudi Arabia

4. Abu Dhabi, UAE

Q.43 Singphos’ Rebellion is associated with which region of present day India?
Ans 1. Tripura

2. Assam

3. Manipur

4. Arunachal Pradesh

Q.44 Which seasonal change marks the withdrawal of monsoon in India?
Ans 1. Rise in daytime temperature

2. Southward shift of ITCZ

3. Onset of monsoon

4. Return of polar jet
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Q.45

Ans 1. Trapezium

2. Rhombus

3. Kite

4. Square

Q.46 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.

(Left) 1 6 $ 1 * 6 5 9 6 % % 1 * * £ 2 * 6 5 $ @ 6 (Right)

How many such numbers are there each of which is immediately preceded by a number
and also immediately followed by a symbol?

Ans 1. 3

2. 4

3. 2

4. 5

Q.47 A man spends 40% of his monthly salary on house rent. If every month, he also spends
₹442 on conveyance and ₹9,115 on grocery and saves the remaining ₹946, his monthly
salary is:

Ans 1. ₹17,603

2. ₹17,468

3. ₹17,505

4. ₹17,475

Q.48 What will come in the place of the question mark (?) in the following equation, if ‘+’ and
‘−’ are interchanged and ‘×’ and ‘÷’ are interchanged?

151 ÷ 3 + 168 × 8 − 145 = ?
Ans 1. 577

2. 557

3. 547

4. 567

Q.49 The volume of a right circular cone is 1078 cm3. Find the total surface area of the cone if
its height is 21 cm. (Use π = 22/7)

Ans 1. 154 cm2

2. 

3. 

4. 

Q.50 A can finish a work in 2 days and B can do the same work in 52 days. B worked alone
for 26 days and left the job. In how many days can A alone finish the remaining work?

Ans 1. 3

2. 2

3. 1

4. 4
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Q.51 What will come in place of the question mark (?) in the following equation if '÷' and '–'
are interchanged and '×' and '+' are interchanged?

56 + 41 ÷ 12054 – 123 × 891 = ?
Ans 1. 811

2. 3089

3. 1307

4. 1557

Q.52 What should come in place of the question mark (?) in the given series?

99 92 105 98 111 104 ? 110
Ans 1. 117

2. 92

3. 125

4. 97

Q.53 Who was appointed the new Director General of the International Solar Alliance (ISA) in
November 2024?

Ans 1. Ajay Mathur

2. Upendra Tripathy

3. Ashish Khanna

4. RK Singh

Q.54 In a certain code language, ‘LATE’ is coded as ‘8054’ and ‘TEAM’ is coded as ‘4087’.
What is the code for ‘M’ in the given code language?

Ans 1. 4

2. 8

3. 0

4. 7

Q.55 35 is related to 70 following a certain logic. Following the same logic, 24 is related to 48.
To which of the following is 11 related, following the same logic?

(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into their constituent digits. E.g. 13 – Operations on 13 such as
adding/subtracting/multiplying to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)

Ans 1. 23

2. 20

3. 21

4. 22

Q.56 In February 2025, the Broadcast Services Regulation Bill, 2023 was introduced in the
Parliament. What is a key provision under this draft legislation?

Ans 1. Unified regulation of cable, satellite and OTT platforms

2. Mandatory pre-censorship of digital news content

3. Transfer of all broadcasting regulation powers to state governments

4. Ban on airing foreign content between 7 p.m. and 10 p.m.

Q.57 Which of the following tree species is an example of deciduous vegetation in India?
Ans 1. Babool

2. Bamboo

3. Sal

4. Deodar
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Q.58 A hollow spherical shell is made of a metal of density 21 g/cm3. Its internal and external
radii are 8 cm and 9 cm, respectively. What is the weight (in kg) of the shell?

Ans 1. 21.03

2. 19.096

3. 20.34

4. 16.096

Q.59 What was the life expectancy at birth in India as per the 2021 World Health Organization
data?

Ans 1. 70.8 years

2. 67.3 years

3. 65.3 years

4. 72.1 years

Q.60 The product of two consecutive positive integers is 960. If the smaller of these two
integers is represented by x, which of the options below will correspond to the equation
for finding the value of x?

Ans 1. x2 − x + 960 = 0

2. x2 + x − 960 = 0

3. x2 − x − 960 = 0

4. x2 + x + 960 = 0

Q.61 “Swadesh Sevak Home” is related to which of the following national freedom
initiatives?

Ans 1. Home Rule Movement

2. Ghadar Movement

3. Non-Cooperation Movement

4. Swadeshi Movement

Q.62 VBDP is related to ZWHK in a certain way based on the English alphabetical order. In
the same way, DRLF is related to HMPA. To which of the following is LHTV related,
following the same logic?

Ans 1. OCWR

2. QBYR

3. QDYP

4. PCXQ

Q.63 P is a point outside a circle and is 17 cm away from its centre. A secant drawn from the
point P intersects the circle at points A and B in such a way that PA = 8 cm and AB = 7
cm, where PB > PA. The radius of the circle is:

Ans 1. 13 cm

2. 12 cm

3. 15 cm

4. 14 cm
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Q.64 Mr. T starts from Point D and drives 3 km towards the east. He then takes a right
turn, drives 7 km, turns right and drives 6 km. He then takes a right turn and
drives 4 km, and then turns right and drives 3 km. He takes a final left turn, drives
1 km and stops at Point H. How far (shortest distance) and towards which
direction should he drive in order to reach Point D again? (All turns are 90
degree turns only unless specified.)

Ans 1. 2 km towards the south

2. 7 km towards the west

3. 5 km towards the east

4. 2 km towards the north

Q.65 In a certain code language,
'A + B' means 'A is the mother of B',
'A – B' means 'A is the brother of B',
'A × B' means 'A is the wife of B' and
'A ÷ B' means 'A is the father of B'.

Based on the above, how is M related to Q if 'M – N ÷ O + P × Q'?
Ans 1. Wife's Father's Brother

2. Wife's Mother's Father

3. Wife's Father's Father

4. Wife's Mother's Father's Brother

Q.66 Which of the following states announced the 'Ama Similipal Yojana' with a budget outlay
of ₹50 crore to enhance livelihoods and promote ecotourism and cultural tourism?

Ans 1. Karnataka

2. Assam

3. Madhya Pradesh

4. Odisha

Q.67 What is the standard method to save your work in PowerPoint?
Ans 1. Select 'Save' from the Design tab

2. Use the File tab and select 'Save' or press Ctrl + S

3. Exit the program without saving

4. Click on the Insert tab

Q.68

Ans
1. 

2. 

3. 

4. 

Q.69 The Maski Ashoka Inscription is situated in which state of India?
Ans 1. Bihar

2. Andhra Pradesh

3. Odisha

4. Karnataka
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Q.70 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusion(s) logically follow(s) from the
statements.

Statements:
Some water is pink.
All pink are buildings.
All buildings are tall.

Conclusions:
(I) Some pink is water.
(II) Some buildings are pink.

Ans 1. Both conclusions (I) and (II) follow.

2. Neither conclusion (I) nor (II) follows.

3. Only conclusion (II) follows.

4. Only conclusion (I) follows.

Q.71 The average of three numbers is 23. If two numbers are 11 and 25, the third number is:
Ans 1. 34

2. 32

3. 35

4. 33

Q.72 A trader lost 5% by selling a shirt for ₹950. He will gain x% by selling it for ₹1,360. The
value of x is:

Ans 1. 51

2. 46

3. 36

4. 26

Q.73 Which output device is specifically designed to produce high-quality printed
graphics and text?

Ans 1. Joys�ck

2. Inkjet Printer

3. Dot Matrix Printer

4. Projector

Q.74 Which keyboard shortcut is used to make the selected text bold in MS Word 365?
Ans 1. Ctrl + I

2. Ctrl + B

3. Ctrl + D

4. Ctrl + U

Q.75 Who among the following is appointed as the President of the upcoming COP30
Summit?

Ans 1. Luiz Inácio Lula da Silva

2. Marina Silva

3. André Aranha Corrêa do Lago

4. Jair Bolsonaro
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Q.76 Seven boxes, D, E, F, G, S, T and U, are kept one over the other but not necessarily in
the same order. Only two boxes are kept between T and E. Only S is kept above G. No
box is kept below E. D is kept at some place below F but at some place above U. Which
box is kept third above U?

Ans 1. G

2. D

3. T

4. F

Q.77 Based on the English alphabetical order, three of the following four letter-clusters are
alike in a certain way and thus form a group. Which letter-cluster DOES NOT belong to
that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. LKP

2. QRU

3. EFI

4. MNQ

Q.78 In November 2024, NITI Aayog launched the 'Accelerating Sustainable State Energy
Transition (ASSET)' initiative. What is the primary objective of this initiative? 

Ans 1. To develop nuclear energy infrastructure across states

2. To enhance energy efficiency in industrial sectors

3. To support states in achieving their renewable energy targets

4. To promote electric vehicle adoption in urban areas

Q.79 The sum of the age of A and 4 times the age of B is 34 years. When 3 times the age of A
is added to 7 times the age of B, the result is 97 years. The sum of the ages (in years) of
A and B is:

Ans 1. 28

2. 31

3. 33

4. 30

Q.80 The population of a village was 1,10,000. It increased by 5% in the first year and
increased by 25% in the second year. Its population after two years is _______.

Ans 1. 1,44,375

2. 1,37,500

3. 1,15,500

4. 1,43,000

Q.81 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of :: ?

# : NHO :: SMT : %
Ans 1. # = PJQ, % = QKR

2. # = PJQ, % = QLR

3. # = PJO, % = QKR

4. # = PJQ, % = QKS
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Q.82 C, O, U, N, T, and Y live on six different floors of the same building. The lowermost floor
in the building is numbered 1, the floor above it, number 2 and so on, till the topmost
floor is numbered 6. Only two people live above C. Only two people live between C and
T. Only N lives between C and U. Y lives immediately below C. Who lives on the floor,
numbered 2?

Ans 1. T

2. N

3. U

4. O

Q.83 T travelled 576 km, 630 km and 315 km at the speeds of 16 km/hr, 7 km/hr and 9 km/hr,
respectively. Find his average speed in km/hr.

Ans
1. 

2. 

3. 

4. 

Q.84 In Windows 10 File Explorer, how can you group files by their type?
Ans 1. Use the 'View' tab and select 'Details'

2. Use the 'Group by' option and select 'Type'

3. Rename all files with the same type

4. Use the 'Sort by' option and select 'Name'

Q.85 Seven boxes, A, B, C, D, E, F and G, are kept one over the other but not necessarily in
the same order. Only three boxes are kept below B. Only two boxes are kept between B
and G. Only A is kept immediately above E. F is kept in some place below D and in some
place above C. How many boxes are kept below C?

Ans 1. 2

2. 4

3. 1

4. 3

Q.86 What is the term duration for representatives in municipalities in India?
Ans 1. 7 years

2. 10 years

3. 3 years

4. 5 years

Q.87 Town P is to the east of Town Q. Town Q is to the south of Town R. Town R is to the east
of Town S. Town S is to the west of Town T. Town P is to the south-west of Town T. What
is the position of Town R with respect to Town T?

Ans 1. West

2. South

3. East

4. North
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Q.88 After allowing a discount of 80%, the value of an oven is ₹5,180. If no discount is
allowed, then the shopkeeper gains 48%. Find the cost price (in ₹) of the oven.

Ans 1. 17,502

2. 17,503

3. 17,501

4. 17,500

Q.89 If 1 is added to each odd digit and 2 is subtracted from each even digit in the number
3816427, how many digits will appear more than once in the new number thus formed?

Ans 1. Four

2. One

3. Two

4. Three

Q.90

Ans 1. 

2. 

3. 

4. 

Q.91 What is the central theme of the first five anthologies (Kuruntokai, Narrinai, Akananuru,
Ainkurunuru, and Kalittokai) of the Ettuttokai in the Sangam literature?

Ans 1. Philosophy

2. Akam

3. Religion

4. Puram

Q.92

Ans 1. 56 minutes

2. 42 minutes

3. 50 minutes

4. 49 minutes

Q.93 In acidic medium, the balanced redox reaction for MnO₄⁻ + Fe²⁺ → Mn²⁺ + Fe³⁺ is:
Ans 1. MnO₄⁻ + 3Fe²⁺ + 2H⁺ → MnO₂ + Fe³⁺ + H₂O

2. MnO₄⁻ + 5Fe²⁺ + 8H⁺ → Mn²⁺ + 5Fe³⁺ + 4H₂O

3. MnO₄⁻ + 2Fe²⁺ + H₂O → Mn²⁺ + Fe³⁺

4. MnO₄⁻ + Fe²⁺ → MnO₂ + Fe³⁺

Q.94 In February 2025, what was the protein isoform '1N4R tau' identified by the University of
Cologne being explored for?

Ans 1. Managing chronic kidney disorders

2. Preventing insulin resistance

3. Treating Alzheimer’s disease

4. Curing sickle cell anemia
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Q.95 Given that 1460.93 = x, 1460.22 = y and xz = y7, then the value of z is close to:
Ans 1. 2.61

2. 3.6

3. 1.66

4. 5.05

Q.96 The average of Anwar's marks in seven subjects is 75. His average in six subjects
excluding Science is 70. How many marks did he get in Science?

Ans 1. 105

2. 107

3. 104

4. 106

Q.97 Which is NOT an advantage of a Lok Adalat?
Ans 1. Binding decisions

2. Speedy resolution

3. No court fees

4. Right to appeal

Q.98 Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which letter-cluster pair DOES NOT
belong to that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. NK−LI

2. TQ−RO

3. KH−HH

4. YV−WT

Q.99 Which of the following ratios is the greatest?
Ans 1. 33 : 51

2. 37 : 64

3. 32 : 86

4. 26 : 59

Q.100 In December 2024, India mourned the passing of Dr Manmohan Singh. In which year did
Dr Manmohan Singh first become the Prime Minister of India?

Ans 1. 2004

2. 1999

3. 2001

4. 1991

Click To Join Telegram PARMARSSC




